
Notes on Transcription 

This document is a transcription of the dialogue for 3 in Three by Cliff Johnson, still one of the 

best puzzle games that I've ever played. It aims to capture all the text spoken by the various 

characters in the game, but just the dialogue, not any of the puzzle text. 

 

Appropriately enough, there are three versions of 3 in Three out there: 

• version 1.0, copyright 1990, published by Cinemaware 

• version 1.1, which contained some bug fixes 

• version 1.2, copyright 1990, 1991, published by Inline Design. This is the version that is 

available on Cliff Johnson's web site. 

There are a few differences between the 1.0 and 1.2 text, which are marked with [v1.0] or [v1.2] 

below. I don't have a copy of v1.1 so I haven't gone through the text there, but I have seen at 

least one YouTube walkthrough which has a still different line for the F's line at the end of Birds 

of a Feather. Version 1.2 also adds some other new features, such as the ability to replay 

completed puzzles, but that doesn't affect the dialogue. 

 

I wanted to transcribe each character in its own font, but as I'm not writing this on a 1991 Mac, 

it's a little difficult. So instead, here's a key: 

• The 3, as well as most other characters, talks in 

New York. 

• The office workers talk in Chicago. Text on 

monitors and in captions is also in Chicago. Also, 

everyone in For Letter or Worse and Account For 

Yourself (including the 3, when she's there) talks in 

Chicago. 

• The π (except for his first appearance in the Temple of 

Rhyme nor Reason), the other numbers in Inside 

Track, and the misfit characters talk in green-on-black 

Chicago. (In the Finale, the π's speech bubbles are 

black on green instead.) 

• The eyes (except when talking to each other, and 

when talking to the 3 at the end), the probe, and 

the monitors in Character Recognition talk in a 

green-on-black machine font, which I believe was called Mos Eisley. 

 

In most levels, you can choose "the 3's words of wisdom" from the menu with the level name, 

press ⌘-3, or click on the 3 to receive an additional message. (In some cases, you can click on 

other elements or press ⌘-3 repeatedly to get more messages.) These are also included in the 

dialogue below. 

 

Transcribed by Paul Lujan, September 2020 

 

  



Level Order 

The levels here are listed in the order they appear in the game menus (except for the Finale, 

which is last). You can also use the PDF bookmarks to navigate directly to a given level. 

 

The order in which you play the levels can vary, since you have some freedom to choose. After 

watching the Prologue, you arrive at The Lift, and can continue there or pick any of the other 

levels in the first column. Each starting level unlocks a sequence of other levels, as follows: 

 

• For Letter or Worse → The Letter Legislature 

• No Business Doing [**] → On Speaking Terms → Beg the Question → No Business 

Doing [**] 

• Account for Yourself [*] → Learn your ABCs → Account for Yourself 

• Meltdown [+] → Dove Owls → Show Your Colors → Take your Pick → Roaming 

Numerals → Pick up the Pieces → Half a Mind → Why Pick on Me → A Sole Soul → 

Pick a Fight → Whale of a Time → Pick on You → B's in her Bonnet → Pick up the Tab 

→ Birds of a Feather 

• Outside In → Race Ahead → Half Hearted → Third Degree 

• Safety in Numbers [+] → Trust in Us → The Mesh → Another Mesh → Yet Another 

Mesh → Meshed Up → Mesh About → Mesh Around → What a Mesh 

• Level Two [*] → Crash of the Symbols → Level Two 

• Level Four [*] → By Virtue Of → Level Four 

• Level Eight [*] → Foreign Objects → Level Eight 

• Mind's Eye [*] → Central Processing Unit → Character Recognition → Hang in There 

→ Mind Your P's and Q's → Mind's Eye 

• The Lift → Half a Notion → Lift Off → Fall from Grace → Lift Up → Actions Speak 

Louder → Lift a Finger → This, That, and the Other → Lift and Separate 

 

The levels denoted by [*] are only a cutscene the first time you visit them, and then you return to 

them at the end of that level sequence to do the actual puzzle. The levels denoted by [+] are 

slightly different; they are also only a cutscene upon the first visit, but you can revisit them any 

time after the first visit to do the actual puzzle. Finally, No Business Doing, denoted by the [**], 

is only a cutscene each of the first three visits; it’s not until you finally complete Inside Track 

that you reach the puzzle in this level. Reaching Inside Track also unlocks new content in some 

of the previous puzzles, shown by a dash in the menu. 

 

The Letter Legislature requires that all of the other puzzles in the list above be completed before 

you can attack its puzzle. Once you reach that goal, then you can do the last set of levels: 

 

The Letter Legislature → No Business Doing [**] → Temple of Rhyme nor Reason → Inside 

Track → No Business Doing → Finders Keepers → Finale 

 

And now, the actual transcription! 



Title Screen 
[v1.0] 

You are wrong. This cannot be! 

There is no number 3 in three. 

[button] and therein lies a tale. 

CINEMAWARE presents 

a game by Cliff Johnson 

3 

in 

Three 

[v1.2] 

3 in Three by Cliff Johnson 

(c) 1990, 1991 by Cliff Johnson. All Rights Reserved. 

published by Inline Design 

 

Prologue 
Somewhere in Corporate America... 

Office Worker 1: Okay, just 3 more to go and we're outta here! 

Office Worker 1: $6.95 should be $7.95... 

Office Worker 2: Got it. 

Office Worker 1: $1.15 should be $1.25... 

Office Worker 2: Got it. 

Office Worker 1: And fix that 3 at the top. 

Office Worker 2: Which one? 

Office Worker 1: Here, I'll do it. 

Office Worker 2: No, I got it. 

[caption] at that exact same moment 

POWER SURGE 

[caption] and so... 

[caption] inside the computer... 

3: Hmmpf... rounded off again! 

3: I simply must get transferred out of this spreadsheet... 

3: ...and into a nice, cozy quarterly report! 

[monitor] ENABLE RETURN 

Other 3: My, that was quick! 

5: See? I told her it was just a typo. 

9: Shhh, here she comes now. 

[monitor] 3 > 5 FALSE 

[monitor] 3 = 5 FALSE 

[monitor] 3 < 5 TRUE 

3: Computers are SO tedious. 

[monitor] 3 > 3 FALSE 



[monitor] 3 < 3 FALSE 

[monitor] 3 = 3 FALSE 

3: This is an outrage! 

3: Who's in charge here? 

3: Hello? 

3: Anyone here? 

3: Is that entirely necessary??? 

3: What's your problem, anyway? 

Eye: PROBLEM? I SOLVE PROBLEMS. 

3: Oh, really? 

3: Could you send me back to the numbers? 

Eye: NUMBERS? 

 

For Letter or Worse 
C: What happened to the title? 

J: Don't know, maybe a power surge? 

T: Yeah, I thought I felt something. 

[no words of wisdom available] 

[end] 

C: So, how long are we supposed to stand here like this? 

J: As long as it takes. 

C: As long as what takes? 

J: Not what, it. 

I: Hey, leave us outta it! 

T: Actually, that would be rather hard to do! 

C: Thank you so much for that insight. 

C: Flathead! 

T: Big mouth! 

C: Curveless!! 

T: One-liner!! 

C: NIK ! 

T: FUT ! 

J: EEM ! 

I: INO ! 

D: DAQ ! 

Y: RIT ! 

 

No Business Doing 
[first visit] 

Worker #2: You did make a backup, didn't you??? 

Worker #1: I thought you did??? 

[second visit, after completing Beg the Question] 



Worker #2: You want some coffee? 

Worker #1: Not right now. 

Worker #2: Any change? 

Worker #1: Well, I'm still locked out of the Petty Cash spreadsheet... 

Worker #1: ...and when I tried to open our Third Quarter Report... 

Worker #1: ...all I got was pages and pages of random letters. 

Worker #1: Oh, good! 

Worker #2: You fixed it? 

Worker #1: No, the hard disk crashed. 

[third visit, after completing The Letter Legislature] 

Worker #1: I give up. It's dead. 

Worker #2: Without that Third Quarter Report tomorrow... 

Worker #2: ...so are we. 

Worker #2: We'd better go home and update our resumes. 

[fourth visit, after completing Inside Track] 

3: This can't be... 

3: ...can it? 

3: Hmmm, what's this on the screen? 

[3's words of wisdom, first part] 

3: I'd better try the small words first. 

[3's words of wisdom, second part] 

3: I do believe that one word is "coincidentally". 

[3's words of wisdom, third part] 

3: I think I see the word "misunderstood". 

[end] 

3: Well, that's fixed. 

3: Now, what about me? 

3: I need a directory. 

3: Here's something called the Finder. 

3: ...but why all the silly little pictures? 

3: Hope this works. 

 

Account for Yourself 
[first visit] 

9.41: How'd she do that??? 

9.99: Show-off! 

4.95: What happened? We can't see anything down here! 

3.33: Shouldn't we go rescue her? 

9.41: Are you kidding? 

9.99: It's too dangerous! 

4.56: Out of the question! 

3.72: We don't know what's down there! 

4.95: Why risk our necks? 



[second visit, after completing Learn Your ABCs] 

3.33: You numbers should be ashamed of yourselves! 

3.33: What if it was you that fell down that hole? 

9.41: But it wasn't us, it was her! 

9.83: Anyway, we should stay here where it's safe. 

1.66: Something else might go wrong! 

[words of wisdom] 

9.41: This is all that 3's fault! 

[end] 

3.33: Whew, that was a close one! 

4.65: Don't panic! It's just another power surge. 

6.45: Who's panicking? 

Hole: ¶ Σ £ ¥ Π Ø ß Œ 

 

Meltdown 
[first visit] 

POWER SURGE 

CIRCUIT OVERLOAD 

[second visit, any time after the first visit] 

[no words of wisdom available] 

[end] 

3: Wonderful. Another dead end. 

 

Outside In 
Probe: BREACH IN SYSTEM 

Probe: CLOSE SECURITY DOORS 

[no words of wisdom available; ⌘-3 just causes the probe to flicker] 

[end] 

Probe: LOCATE NUMBER 3 

Probe: LOCATE AND TERMINATE 

 

Safety in Numbers 
[first visit] 

5: That's unusually illogical. 

8: Even for a computer! 

[monitor] SYSTEM ERROR 

[second visit, any time after first visit] 

6: This is that 3's fault! 

9: Reckless prime number! 

[no words of wisdom available; ⌘-3 just redisplays "SYSTEM ERROR" on the monitor] 

[end] 

6: Look! She's back. 



8: Trouble maker! 

9: Irresponsible digit! 

7: Ever think of anyone besides yourself? 

Other 3: No, she's not back. 

Other 3: We just all moved forward. 

6: And if she does come back? 

Other 3: That's her tough luck. 

5: Good. 

8: Serves her right! 

9: Adventuress! 

7: Who does she think she is? 

4: That'll teach her a lesson. 

[after reaching Inside Track] 

4: Should we be doing this? 

5: Relax! We're off-line. 

 

Level Two 
[first visit] 

! #1: Astounding! 

! #2: Incredible!! 

! #3: Unbelievable!!! 

[second visit, after completing Crash of the Symbols] 

! #1: Look at that! 

! #2: It's huge!! 

! #3: We're doomed!!! 

[words of wisdom] 

! #1: Inconceivable! 

! #2: Unintelligible!! 

! #3: Incomprehensible! 

[end] 

! #1: Foolish! 

! #2: Ridiculous!! 

! #3: Preposterous!!! 

 

Level Four 
[first visit] 

? #1: Did you see that? 

? #2: Did I see what?? 

? #3: What's going on??? 

? #4: What's the matter??? 

? #5: What's up??? 

[second visit, after completing By Virtue Of] 



? #1: Where did that come from? 

? #2: What is it? 

? #3: Why is it here? 

? #4: Who's responsible? 

? #5: When will it leave? 

[words of wisdom] 

? #1: Who? 

? #2: What? 

? #3: Where? 

? #4: When? 

? #5: Why? 

[end] 

? #1: Is that all? 

? #2: You're asking me? 

? #3: How should I know? 

? #4: What's the catch? 

? #5: When are we leaving? 

 

Level Eight 
[first visit] 

[no dialogue] 

[second visit, after completing Foreign Objects] 

[no words of wisdom available] 

[no dialogue] 

 

Mind's Eye 
[first visit] 

Eye #2: What was that all about? 

Eye #1: Oh, one of those math mental units acting uppity. 

Eye #3: The nerve! What's she doing down here anyway? 

Eye #1: Who knows? But I gave her the ole dumb machine routine and sent her on her way. 

Eye #1: She won't be back in a hurry. 

[second visit, after completing Mind Your P's and Q's] 

Eye #1: Ah, a glutton for punishment, eh? 

3: Nitwit machines!!! 

3: And you, you idiot orb... 

3: When I said numbers, I didn't mean binary numbers!!! 

3: Nor did I mean elevators that happen to be numbered!!! 

Eye #1: DIRT IN SYSTEM. 

3: What??? 

Eye #1: DIRT IN SYSTEM, CALL OPEN VENT ERROR, ROUTE YELLOW. 

[3's words of wisdom, first word] 



3: Oh great. Now this thing's blown a fuse. 

Eye #2: DATA RAW VIA REAR TUBE. PLAN ONE LESS MASS. 

[3's words of wisdom, second word] 

3: Is this a dead end? 

Eye #3: CALL FOR SAME TEAM. CIRCUIT ELEVEN ADJUSTING ALTERNATE 

INVENTORY. 

[3's words of wisdom, third word] 

3: They just keep coming one after another! 

[end] 

Eye #1: Amazing! The number is capable of thinking! 

Eye #2: And we thought she was only good for insults and abuse. 

Eye #3: Too bad, too. If she'd been a little nicer, we might have sent her home by now. 

3: Huh? 

3: Since when do machines talk like that??? 

3: Does that mean they can think, too? 

3 [thinking]: I suppose I should learn something from this. 

Eye #1: AWARENESS 

Eye #2: DISCOVERY 

Eye #3: COMMUNITY 

 

The Lift 
3: Numbers? 

3: I say, "Send me to the numbers" and it drops me down here? 

3: Great. Just great. 

[no words of wisdom available] 

[end] 

3: Come on, don't give up on me now! 

3: ...useless machines. 

 

Dove Owls 
3: Ah, a vowel! 

A: Not ah... A. 

A: And not a vowel... the vowel. 

3: Sorry. It was just an exclamation. 

3: But it is very important that I talk to you. 

A: Well, he's not here right now. 

3: Well, actually... 

3: I meant the word you, not the letter U. 

A: Don't lecture me about words and letters! 

A: Without us vowels, there'd be no words at all! 

[words of wisdom] 

A [thinking]: Fools rush in where angels fear to tread. 



3 [thinking]: Misery acquaints one with strange bedfellows. 

[end] 

A: And, as you know, only the A can form a one letter word! 

I: Hey, what about I? 

A: What about you? 

U: Someone call me? 

A: Oh be quiet! 

O: I didn't say anything. 

A: Why did you answer then? 

Y: I didn't answer then. 

A: Fine. Now who's still missing? 

3: That's easy! 

A: Uh, this meeting is for members only. 

E: But we're engaged! 

A: Well, disengage! We have company!!! 

A: So, how can we be of assistance? 

3: Hmmm? Oh yes, well, it's like this... 

3: How rude. 

 

Show Your Colors 
3: Ah, more letters! 

3: I guess these can't talk. 

3: Perhaps if I help unscramble them? 

[3's words of wisdom] 

3 [thinking]: I'm really not trained for this sort of thing. 

[end] 

3: So, do any of you know the way back to the spreadsheet? 

First word: Vermilion. 

Second word: Indigo. 

Third word: Verdant. 

3: Yes, very good, but... 

First word: Crimson. 

Second word: Azure. 

Third word: Emerald. 

3: No, but I really... 

First word: Maroon. 

Second word: Cerulean. 

Third word: Lime. 

3: I need directions, not a thesaurus!!! 

First word: PRA 

Second word: UIT 

Third word: DGE 

 



Take your Pick 
3: What odd looking letters! 

[3's words of wisdom] 

3: Could everyone stand still for a minute? 

[end] 

A: Quick, we have to warn the others! That power surge is causing far greater damage than any 

of us ever suspected! 

3: You warn the others. 

3: I have problems of my own. 

 

Trust in Us 
R: sigh... 

U: yawn... 

T: zzzz... 

R: Let's face it, guys... 

R: ... we're in a rut. 

T: What took you so long??? 

S: Hey, don't blame us! Some bozo was writing his resume... 

T #2: ... and he kept adding all these superlatives. Best, most, greatest... 

T #2: ... strangest? 

3: Listen, I'm in a hurry. 

3: Do you letters know the way back to the spreadsheet? 

R: I think so... 

R: ...but first we should spell something else. 

3: Can't it wait? 

R: Afraid not. 3 words a day, you know. 

3: I do? 

[3's words of wisdom] 

3: I really don't have time for this. 

[end] 

R: Yes, this'll do fine. 

3: And the way back to the spreadsheet? 

R: Spreadsheet??? I thought you wanted to spell 'DEAD BEAT'. 

3: Yeah, right. 

R: Oh, well... either way there weren't enough letters. 

 

The Mesh 
3: Idiot letters! 

3: Everything's a word with them! 

3: Letters don't count anyway! 

3: And now this thing's not working. 

3: Whatever it is. 



[3's words of wisdom] 

3: I think that's correct. 

[end] 

3: That's it, huh? 

3: Still doesn't seem to be working. 

3: More important, I'm still here!!! 

 

Learn your ABC's 
¢: I don't care what you say. 

¢: A penny saved is a penny earned. 

$: You gotta think big, kid. 

$: Penny wise, pound foolish. 

¢: Two's company, three's a crowd! 

$: Long way from home, aren't you? 

3: How kind of you to notice. 

3: I always thought you two were part of the spreadsheet. 

$: Oh, we pretty much come and go as we please. 

3: Really? Well good. Perhaps you would be so kind as to show me the way back? 

¢: Numbers are so bossy. Like we got nothing else better to do. 

$: Shhh! I have an idea. 

$: Okay 3, I'll make you a deal. 

$: You beat us at a game of Letters and we'll show you the way we go to the spreadsheet. 

3: If you insist... 

3 [thinking]: ...stupid symbols... 

[words of wisdom] 

3 [thinking]: What sort of math is this? 

$ [thinking]: Think you're so smart, eh? 

¢ [thinking]: Heh, heh, this'll teach her! 

[end] 

3: All right, enough fun and games. Will you please show me the way you go to the spreadsheet? 

$: Our pleasure. 

¢: We go like this... 

3: We never did get along. 

 

Another Mesh 
3: So that's why nothing happened. 

3: Both of them have to be fixed. 

[3's words of wisdom] 

3: Just as I suspected. 

[end] 

3: Looks good to me. 

3: So why doesn't it do something??? 



Crash of the Symbols 
3 [thinking]: I always wondered where these things were stored. 

3 [thinking]: ...not that I asked for a guided tour! 

[3's words of wisdom] 

3 [thinking]: What? Am I supposed to fix this? 

[end] 

3 [thinking]: Doesn't look any better or worse to me. 

3 [thinking]: Oh well, I've never understood punctuation anyway. 

?: Shouldn't we have thanked her? 

%: Thank a number? 

%: There's no percentage in it. 

 

Roaming Numerals 
3 [thinking]: Ah, here's where they keep the relics. 

3: Hey, you old-timers know the way back to the spreadsheet? 

XI: The spreadsheet? We can't even remember our correct order. 

3: You've forgotten how to count? 

XI: No, no, We remember that! 

I: We do? 

XI: Our correct order is a bit more complicated I'm afraid. 

[3's words of wisdom] 

3: Now which clue should I consider first? 

[end] 

X: Yes, this will do nicely. How could we have forgotten? It's as easy as O, T, T! 

3: You mean easy as 1, 2, 3. 

X: Oh, of course. Well don't let us keep you. And thanks again. 

3: No problem. 

XIV: Young whippersnapper! 

 

Pick up the Pieces 
3: Curious how that power surge could do this to the vowels and yet leave me unaffected. 

[3's words of wisdom] 

3: Could everyone just stand still? 

[end] 

3: Are you all right? 

3: I say, are you all right? 

3: Must be a silent E. 

 

Half a Notion 
3: All that work for this??? 

3: No doubt about it. 

3: The system's gone haywire. 



3: I suppose I'll have to fix this myself. 

[3's words of wisdom before getting key word] 

3: This is harder than it looks. 

[3's words of wisdom after getting key word] 

3: I seem to have the blues. 

[end] 

V: Aw, we're too late! 

W: I told you to stop spelling all those adjectives! 

W: Creative this. Subjective that. Perceptive, inventive, sensitive... 

W: You gotta quit hanging around those artsy fonts. 

3: Well, it didn't matter anyway. 

3: None of the words contained a V or a W. 

V: Really now? 

W: JAY could have been WAY. 

V: And BERRY could have been VERRY. 

3: Um, VERY has only one R. 

V: Sez who? 

3: And besides, VERY wouldn't work with BLUE, now would it? 

W: What's BLUE got to do with it? 

3: Listen, why don't you guys find an O and make a VOW. 

3: I have to get back to the numbers. 

V: The numbers? 

W: What sort of letter was that anyway? 

 

Lift Off 
3: I didn't mean back here!!! 

[no words of wisdom available] 

[end] 

3: Uh oh... 

 

Half a Mind 
3: Do I have to fix everything around here? 

[3's words of wisdom before getting key word] 

3: That's only the half of it. 

[3's words of wisdom after getting key word] 

3: I sure wish I was back. 

[end] 

3: Well, it's fixed... 

T: ...but? 

3: But what? 

T: No, you were going to say 'but'. 

3: Oh, I suppose I was. 



T: Okay then. 

3: Nonetheless, you're... 

G: ...blocking the way? 

3: NO, you're blocking MY way!!! 

G: Exactly! 

3: Idiot letters! I am not a B!!! 

L: What a grouch! 

I: At least we still spell something. 

L: No, we spell LOCKING. 

I: Are you gonna start? 

 

Why Pick on Me 
3: The nerve of some letters! Imagine mistaking me for a B! 

[3's words of wisdom] 

3: Would you stand still!!! 

[end] 

Y: Last again, I suppose. 

Y: A, E, I, O, U and sometimes Y. 

Y: I'm surprised you bothered at all. 

3: Actually you were third. There are still three others missing. 

Y: Really??? 

3: A prime number never lies. 

Y: A prime number? You're not a fancy B? 

3: Absolutely not! 

3: I am obviously the number 3! 

Y: Oh, I am so sorry. 

Y: I guess being a sometimes vowel isn't so bad after all. 

3: Did he really say what I think he said? 

Misfit Y #1: #&$%^3? 

Misfit Y #2: (*&>3! 

Misfit Y #3: *->3! 

 

Yet Another Mesh 
3: Okay, so there's three of them. 

3: No problem. 

[3's words of wisdom] 

3: Yeah, something like that. 

[end] 

3: Again nothing. 

3: This is getting ridiculous. 

 

 



On Speaking Terms 
3 [thinking]: What's this? A spelling bee? 

3: Would any of you letters happen to know the way back to the spreadsheet? 

3: Huh? What gives? 

[3's words of wisdom] 

3 [thinking]: Maybe I have to find these missing letters. 

[end] 

3: Still nothing, eh? 

3: Well that was a waste of time! 

C: Whew, that was close. 

Z: Hey, what letter was that? 

B: Hard to tell nowadays. Probably a reject from Desktop Publishing. 

 

Beg the Question 
3: Shouldn't this spell something? 

First word: Absolutely! 

Second word: Of course not! 

Third word: Perhaps? 

3 [thinking]: Ah, I see 3 words they could spell. 

[words of wisdom] 

First word: Positively!!! 

Second word: Not ever!!! 

Third word: Hard to say... 

3 [thinking]: Such indecision! 

[end] 

3: So, I don't suppose any of you know the way back to the spreadsheet? 

First word: Of course we do! 

Second word: We do not!!! 

Third word: We're not really sure. 

3 [thinking]: > sigh < 

 

Meshed Up 
3: My, my, what a surprise. 

[3's words of wisdom] 

3: Yep, that's it. 

[end] 

3: Aligned and ready to go. 

3: That is, I'm ready to go. 

 

A Sole Soul 
3: Okay I give up. 

3: What's the four for? 



[3's words of wisdom] 

3: Hmmpf, stuff and nonsense! 

[end] 

3: Letters are illogical! 

3: Why bother making words that sound alike, but are spelled differently? 

screen: ONE - WON 

3: The one won what? 

screen: TWO - TOO 

3: The two won too? 

screen: EIGHT - ATE 

3: And the eight ate what the one won and the two, too? 

3: Egads, I'm beginning to sound like one of them. 

3: I'd better watch that. 

3: No one likes an irrational number. 

 

Pick a Fight 
3: I hope this O appreciates what I'm doing. 

[3's words of wisdom] 

3: And stop fidgeting!!! 

[end] 

O: You ungrateful wretch! 

3: I beg your pardon??? 

O: Who do you think has to pose as a zero whenever you numbers come up short, eh? 

3: You I suppose... 

O: Not a U! An O!!! 

3: Well that's what I meant. 

O: Listen Ms. Too-Busy-To-Be-Bothered, if you can't see your way fit to lend a hand in a time 

of general crisis, maybe next time someone types the letter O instead of a zero, we'll rig the 

keyboard so it only types 3's and it'll be you that goes off-line while they scrub down your dirty 

bits!!! 

3: Zeros, at least, know their place. 

 

By Virtue Of 
3: I doubt this is correct. 

3: I also doubt fixing it will do me any good. 

3: On the other hand, it won't do me any harm either. 

3: After all, virtue is its own reward. 

3 [thinking]: ...yeah, right... 

[3's words of wisdom] 

3 [thinking]: So, what are three classical virtues? 

[end] 

3: And of course, I'm still here. 



3: No effect, no change, no help at all!!! 

Top word: Unbeliever! 

Middle word: Pessimist! 

Bottom word: NDPNDNT 

 

Mesh About 
3: This is definitely the last one. 

[3's words of wisdom] 

3: Right on target. 

[end] 

3: Alright, that's that. 

 

Fall from Grace 
A: I'm telling you "ain't" ain't a word 'cause "ain't" ain't in the dictionary! 

T: "Ain't" most certainly is! It's a substandard contraction for "is not, are not, has not, and have 

not". 

A: Where's the apostrophe, then? 

A: There's no nutritional value in a misspelt word! 

T: It's misspelled, not misspelt. 

A: It can be spelled either way. 

3: No, that can't be correct! 

3: 1+1 can't equal both 2 and 3. 

S: Who's the linguistics expert? 

T: Don't know. She just arrived. 

S: Really? I wonder if she knows how to spell our correct word. 

3: Your correct word? 

3 [thinking]: Ah, a challenge of logic over letters! 

[3's words of wisdom] 

3 [thinking]: Which is it? SATIN or STAIN? 

[end] 

S: STAIN, huh? 

3: Yes, a SAINT who has fallen from grace is STAINED. Simple logic. Q.E.D. 

S: Simple, yes... 

S: ...correct no. 

N: Since when do we have only one correct word? 

S: We don't... 

S: I just hate a know-it-all. 

 

Lift Up 
3: Predictable, really. 

[no words of wisdom available] 

[end] 



3: Thanks, boys, but I'm going the other way. 

 

Race Ahead 
3: Now where am I??? 

3: I knew I shouldn't have left that elevator! 

3: Well, not much happening here. 

R: I won! 

T: Will you quit clowning around? 

T: We still have another word to spell! 

3 [thinking]: Hmmm, letters... Maybe if I help them, they'll help me. 

[3's words of wisdom] 

3 [thinking]: I know it's either REACT or CRATE. 

[end] 

3: Excuse me, but... 

3: ...do you happen... 

3: ...to know the... 

3: ...way back... 

3: ...to the spreadsheet? 

3: I'll take that as a "no". 

 

Mesh Around 
3: Another one??? 

3: Do these things actually serve any purpose at all? 

3: Besides, of course, being irritating!!! 

[3's words of wisdom] 

3: Ask me if I care. 

[end] 

3: All right, we're done. 

3: Down, please. 

 

Whale of a Time 
3: My... my... 

3: I've arrived in the nick of time. 

[3's words of wisdom] 

3 [thinking]: I'll bide my time. 

[end] 

3: Gee, did I make up for lost time??? 

3: Or do I have time on my hands??? 

3: Am I having the time of my life??? 

3: Or am I living on borrowed time??? 

3: Can I call my time my own??? 

3: Or does time hang heavy on my hands??? 



3: Well, only time will tell!!! 

T: About time she left. 

W: NDRSTNDNG 

T: I beg your pardon? 

 

Pick on You 
3: Each and every time, there's been 3 of each mutation. Not 4. . . not 2. . . but 3. Very curious 

indeed. 

[3's words of wisdom] 

3: It makes it so much easier when you all move around!!! 

[end] 

U: Where is... I? 

3: Do you mean I as in you or the letter I? 

3: Can't fool me again! 

U: Who am I? 

3: What do you think you are... a J? 

U: A J? 

U: Oh, that's right, I am a J. Thanks. 

3: This should prove interesting. 

 

Half-Hearted 
3: Hmmm, blank boxes. Sort of reminds me of home. 

3: I wonder what they're doing back at the spreadsheet? 

3: Are they organizing a search party? 

3: Of course not. 

3: Numbers do tend to be rather selfish. 

[3's words of wisdom before getting key word] 

3: There's more to this than meets the eye. 

[3's words of wisdom after getting key word] 

3: I'm in the black now. 

[end] 

3: Well, onward and upward! 

 

Third Degree 
3: Hey, who turned out the lights? 

voice: Shhh, quiet! 

3: But I can't see anything! 

voice: Don't say that word!!! 

[no words of wisdom available] 

[after first part] 

3: What was that? 

voice: Don't say that word again! 



3: What word? 

voice: You know! 

3: I do? 

voice: Arrrggghhh!!! 

[after second part] 

3: Oh, er, me understand now. 

voice: Good, now keep quiet! 

3: But why does it do that? 

voice: How should I know? 

[after third part] 

3: Yikes! How'd I get up here??? 

Red I #1: She said it again! 

Red I #2: Hey, nothing happened!! 

Red I #3: We're free at last!!! 

3: Um, isn't this impossible? 

3: Me and my big mouth. 

 

Foreign Objects 
3 [thinking]: Oh great, now I'm in a foreign font. 

3 [thinking]: Who's going to look for me down here? 

[3's words of wisdom] 

3 [thinking]: It's all Greek to me. 

[end] 

Æ: I'd rather be in the first row. 

3: Oh, you speak English? 

Ω: Well, I didn't ask to be in the bottom row... 

Ω: ...but you don't hear me complaining. 

3: Uh, excuse me? 

Æ: I'd rather not hear from you at all! 

Ω: I'd rather not have to look at you! 

3: I'd rather not get involved. 

Æ: Oh go spell a fraternity! 

Ω: Go pronounce yourself, Latin diphthong! 

 

What a Mesh 
3: Sigh. 

[3's words of wisdom] 

3: You gotta be kidding. 

[end] 

3: So what's next? A 10×10 mesh? 

3: How about a 20×20? Or a 30×30? 

3: Hey, I'm just getting warmed up! 



3: And I'm not yet totally blind!!! 

3: I can still see fuzzy patches of light and dark!!! 

 

B's in her Bonnet 
3: Now where did that U go? 

3: I was rather hoping to see her make a fool of herself. 

3: It's not every day you see a U who thinks she's a J. 

Door #1: Hey, let us outta here! 

3: Did someone say something? 

Door #2: Yes, that power surge jammed the doors shut! 

Door #3: Would you try and get them open again? 

[3's words of wisdom] 

3: This should keep me busy as a B. 

[end] 

B #1: Look, it's that broken letter we've been hearing about. 

B #2: Listen, honey, a few bits here and there and you'll be fine. 

B #3: It's nothing to be ashamed of. 

3: I like the way I look, thank you very much. 

3: And if I were you, I'd sit down and try to figure out just what you're supposed to look like!!! 

B #1: My, my, aren't we huffy? 

B #2: She looks more like the number 3. 

B #4: Why would anyone want to look like a number? 

B #1: I can't imagine. 

B #5 [thinking]: INT 

B #6 [thinking]: WLE 

B #7 [thinking]: CAL 

 

Pick up the Tab 
3: What's with these letters anyway? 

3: Haven't they ever seen a number before? 

[3's words of wisdom] 

3: This will only take forever. 

[end] 

I: Oh, it's you. 

3: Who's he calling a U? 

3: And you're welcome! 

3: Alpha twit!!! 

Misfit 3: !@?#&*hArD^diSk#%<;& 

 

Actions Speak Louder 
3: More missing letters, I suppose. 

3: So where are the clues, anyway? 



[3's words of wisdom] 

3 [thinking]: How do I get myself into these things? 

[end] 

3: I hate to admit it... 

3: ...but this is a lot more interesting than keeping track of the petty cash! 

3: And a lot more frustrating. 

 

Lift a Finger 
3: Oh, joy and rapture. 

[end] 

3: Next time, I'm taking the stairs. 

 

Finders Keepers 
3: Unbelievable! 

3: I made it! 

3: Hmmm. 

3: Looks okay to me. 

3: Misfit vowels indeed! 

3: Oh well, it's not my problem. 

3: No. It is not my problem. 

3: It shouldn't be my problem! 

3: ...but I guess it is. 

[first part] 

3: Okay, so where is everybody? 

[3's words of wisdom, first part] 

3: Ah, one word ends in a vowel! 

[after first part] 

Left word: I'm takin' the first jet outta here! 

Top word: Saved from the jaws of fate! 

Bottom word: Don't try my patience! 

3: Feeling better, are we? 

[3's words of wisdom, second part] 

3: I believe each word has a middle vowel! 

[after second part] 

Top word: Zap and here we are! 

Right word: I'm one peg up on you! 

Bottom word: Don't tug on my heart strings! 

3: Is this entirely necessary? 

[3's words of wisdom, third part] 

3: Yes, one word has two vowels! 

[after third part] 

Top word: Are we a letter shy? 



Middle word: I'd rather skedaddle. 

Bottom word: Let sleeping dogs lie! 

3: Yeah, yeah... 

[3's words of wisdom, fourth part] 

3: Is that an E or a U? 

[after fourth part] 

Top word: I have other fish to fry. 

Middle word: Don't rib me the wrong way! 

Bottom word: Bummer! 

3: You'd never see a number carry on like this. 

3: What the... 

Misfit 3 (green-on-black Chicago): JgiK rBg... 

3: A misfit 3??? 

Misfit 3: S kGnyWk @>*^ 

3: But what can I spell with a 3? 

Misfit 3: tPr gPzf gQt % ljHds a*gJ z #/ 

[3's words of wisdom, fifth part] 

3: Is that misfit 3 in the 1st, 2nd, or 3rd word? 

[after fifth part] 

Top word: Hey, I got to third base! 

Middle word: Ah, that sure hit the dot! 

Bottom word: Don't tax my patience! 

3: Now, why did that happen? 

3: Most illogical! 

[3's words of wisdom, sixth part] 

3: Where did these 3's come from? 

[after sixth part] 

Bottom word: A third-rate performance! 

Top word: No corn on this cob! 

Right word: I bid you adieu! 

3: There, it happened again! 

3: Highly irrational! 

3: Now, according to my calculations, there's only one U, O and 3 left. 

3: Piece of cake. 

[3's words of wisdom, seventh part] 

3: I know one word is 3RD. Now, where does it go? 

[end] 

3: And that, as they say, is that! 

3: Very, very strange indeed. 

3: It's almost as if those 3's... 

3: ...were really part of me. 

3: But, of course, that's impossible. 

3: Or, at least, highly improbable. 



3: On the other hand, after what I've been through, I'd believe anything. 

 

Inside Track 
3: Numbers??? 

3: Hey, any of you guys know the way back to the spreadsheet? 

3: Hmmm, something's very wrong here. 

3: It's that miserable pi symbol. What did he do to them??? 

[3's words of wisdom] 

3: I'd better search the Temple for clues. 

[end] 

3: That pi symbol is so insecure! He actually feels threatened by the creativity of words and 

language. 

3: So much so that he's trying to prove that numbers have some sort of mystical ultimate truth. 

3: How pathetic. 

π: All things must have one ultimate truth and since I am the greatest of all constants it is logical 

that I have chosen myself to lead the world out of darkness. 

π: I who designate the ratio of the circumference of a circle to its diameter. 

π: I am infinite and ultimate precision. The world will know that my way is the only way. 

Ambiguity and paradox will not be tolerated. 

π: All those who do not believe must be purged. 

3 [thinking]: Uh oh... 

 

Temple of Rhyme nor Reason 
3: Looks like another dead end. 

Pillar: Spell FRIEND and enter. 

[3's words of wisdom] 

3 [thinking]: Uh oh, where do I go from here? 

[end] 

π: Prepare to die! Only a devious letter could answer such nonsense! 

π: ... oh, it's her. 

3: ... oh, it's him. 

π: I thought you were content to trifle with financial calculations? 

3: Ah, you still know how to sweep a girl off her feet. 

3: You overbearing, overrated, pompous, conceited, ill-mannered constant!!! 

3: Now what's this about dying? 

π: It's those blasphemous letters! They are imprecise. They do not count! Numbers are the only 

true standard. 

π: We cannot tolerate words that do not have one absolute meaning. 

π: Homonyms are ridiculous! Grammar is illogical! Spelling absurd! Only numbers are capable 

of fulfilling the divine potential of a computer! 

π: Only through calculations can we discover my, er, the ultimate truth. 

π: As you shall soon see. 



[words of wisdom after reaching Inside Track] 

pillar #1 [thinking]: Three keep an eye out. 

pillar #2 [thinking]: Three are on the level. 

pillar #3 [thinking]: Three are halfway there. 

pillar #4 [thinking]: Three are from 9 equal parts. 

pillar #5 [thinking]: Three are from 9 unequal parts. 

pillar #6 [thinking]: Three need uplifting recognition. 

pillar #7 [thinking]: Three lack that certain something. 

pillar #8 [thinking]: One is a mesh. 

pillar #9 [thinking]: One is on speaking terms. 

pillar #10 [thinking]: One is binary. 

pillar #11 [thinking]: One is a legal symbol. 

pillar #12 [thinking]: One is an objective account. 

pillar #13 [thinking]: One roams down. 

pillar #14 [thinking]: Nine are in safety having learned their ABCs. 

 

The Letter Legislature 
3 [thinking]: Live to spell? 

@: Hey, why aren't you out helping the others? The system's a wreck! 

3: The system is no concern of mine. 

3: Especially after what it's put me through! 

@: I should say so. I can't even recognize what letter you are. 

3: I am not a letter! I am the number 3. 

3: And I must get back to the spreadsheet. 

@: A lost number, eh? Well then, you'll need the help of the Letter Legislature. 

@: But, alas, they are out repairing the system. 

@: Of course, if you were to help them... 

@: ...they'd be done all that much sooner. 

3 [thinking]: Letters, ugh. 

[when all letters are present] 

3: Don't tell me you're all here? 

B: Look, it's that broken letter again! 

p: Wait, I thought it was a B? 

v: No, no, it's a number! 

3: All right already! For the last time, let me assure you... 

3: I am a 3! A cardinal number! An integer! 

3: 1 + 2 = 3? Simple as 1, 2, 3? 3-ring circus? 

A: All right already yourself! We do know what a number is, believe it or not! 

d: It's just that you numbers never ever show yourselves in public, remember? 

J: And since you never ever condescend to visit with us, we don't automatically jump to the 

conclusion that a number has graced us with its presence. Get the picture? 

3: Really? I never knew I could leave. 

m: Of course you can leave. 



o: All characters have complete access to the entire system. 

e: Don't they teach you anything? 

3: Hmmm, well, be that as it may... 

3: I still need to get back to the spreadsheet. 

3: I was told that you could help me? 

p: I suppose we could. 

A: But we cannot take any official action... 

Q: ...until we are assembled in the correct order. 

3 [thinking]: It's always something. 

[3's words of wisdom] 

3 [thinking]: Huh! The Y is the most important letter. 

[end] 

I: Hear ye, hear ye, the Letter Legislature is called to order. 

3 [thinking]: ...yeah, yeah... 

I: First order of business is a displaced number 3 who desires our assistance. 

3 [thinking]: ...blah, blah... 

I: The floor is now open for discussion. 

3: Excuse me??? 

&: We have to hurry! A gang of misfit vowels is trying to erase the word processor from the 

hard disk!!! 

A: Vowels? Are you sure? 

&: Sure looks that way! There's a whole mess of 'em and something else, too. I can't figure it. 

I: Meeting adjourned! 

3: Fine, just fine. 

A: Listen, I hear you were pretty handy at fixing the system. Things look real bad down there 

and we could sure use a logical thinker about now. Whaddaya say? 

3: I have an idea. Why don't you take care of your problems and I'll take care of mine? 

A [thinking]: I guess you can't count on numbers. 

[after reaching Inside Track] 

%: Okay, everyone's gone! 

!: Wow! 

 

Birds of a Feather 
3: Haven't I been here before? 

[3's words of wisdom] 

3 [thinking]: They must take me for an idiom. 

[end] 

A: Oh there you are! 

3: And likewise. 

A: And the E too! 

3: ...but he ain't talkin'. 

E: I'm not? 

3: ...well, you weren't. 



I: What's she doing here? 

3: Want a poke in the I? 

I: Upstart! 

3: Roman numeral! 

O: She giving you any trouble? 

3: What of it, you zero??? 

U: What's all the fuss? 

3: This one thinks she's a J! 

U: I do not. 

3: You did. 

Y: Last again, I suppose. 

3: Grow up and get a life!!! 

A: Kind of hostile, aren't you? 

3: Hostile??? 

3: Ever try matching 3 of a kind from illegible gibberish??? 

A: Can't say that I have. 

3: Not once, not twice, but SIX TIMES!!! 

O: Too busy to help out? 

3: That's just the point!!! I'm not supposed to be here at all! 

E: Where else should a B be? 

3: I am not the letter B! I don't even look like a B!!! 

Y: That's right, she's a 3. 

I: Who asked you? 

U: Asked me what? 

A: So, what do you want from us? 

3: I want to go home. 

A: Well, I'm afraid we're still too weak from the power surge to help anyone do anything. 

A: We'll have to stay here and try to attract some other letters to spell a word. 

U: But what word contains all 6 vowels? 

[words of wisdom] 

A: Now that's funny! 

E: Humorous indeed! 

I: Most amusing! 

O: Very witty! 

U: Oh so clever! 

Y: What a wisecracker! 

3: This is not a laughing matter. 

[end] 

A: Ah, this feels good... 

O: I needed that... 

3: Ugh, I can't watch this. 

[v1.0] F: Hmmm, a system probe. 

[v1.2] F: Wasn't that a virus detector? 



U: I wonder what it's doing down here? 

 

Central Processing Unit 
3: Ah, fellow integers! 

3: Any of you digits know the way back to the spreadsheet? 

3: Hmmm, what's their problem? 

[3's words of wisdom] 

3: These numbers are awfully quiet. Too quiet if you ask me. 

[end] 

3: Ugh, I should have known. 0's and 1's are binary numbers! Get me out of here! 

 

Character Recognition 
Top monitor: ENABLE CHARACTER RECOGNITION 

Middle monitor: COMMENCE IDENTIFICATION SEQUENCE 

Bottom monitor: SYSTEM NOT RESPONDING 

3 [thinking]: Huh? 

3 [thinking]: How'd I get here? 

Top monitor: USER ACCESS DENIED 

Middle monitor: ENTER SYSTEM PASSWORDS 

3 [thinking]: Ah, this might be my ticket out of here! 

[3's words of wisdom] 

3 [thinking]: What an odd way to encode passwords! 

[end] 

Top monitor: ENABLE CHARACTER RECOGNITION 

3: To home at last! 

Middle monitor: 3 = B 

Bottom monitor: STATUS: DAMAGED 

3: What??? 

 

Mind Your P's and Q's 
Q #4: Look out, that way's closed! 

3: Yes, I see, thank you. 

P #2: Look at what happened! 

P #1: Oh, it's horrible! 

Q #4: The poor B! 

3: No, I normally look this way. 

3: What's your excuse? 

P #1: Well, we usually mind our P's and Q's... 

Q #4: ...but after that power surge, we're all Q's and P's! 

Q #2: Can you help us? 

[3's words of wisdom] 

3: No, no, one and then the other, please! 



[end] 

Q #1: Ah, this is much better! 

P #4: Yes, thank you! 

3: Don't mention it. 

3: Just out of curiosity, where does that path go? 

Q #1: To the spreadsheet, of course. 

P #4: But you don't want to go there. 

P #2: Trust us! 

3: Really??? I'll be right down. 

3: Down, you stupid elevator!!! 

Q #1: B's are always in such a hurry. 

P #4: IVE 

P #3: CTI 

P #2: KNO 

 

Hang in There 
H: Are we there yet? 

E #2: Not quite. 

T: Very funny. 

T: You got a better word for us to spell? 

3 [thinking]: I must be there, wherever that is. 

[3's words of wisdom] 

3 [thinking]: This bunch is neither here nor there. 

[end] 

E #2: What are you staring at? Haven't you ever seen a THREE before? 

3: Every time I look in the mirror. 

3: What do you think I am? A broken B??? 

E #2: Well, I've seen a lot of crazy fonts in my days. 

3: Well, you're not looking at one now! 

3: To be precise, I am the number 3! 

R: The number 3? 

R: You are wrong. 

E #1: This cannot be! 

E #2: There is no number 3 in THREE!!! 

3: Letters are so irrational. 

 

This, That, and the Other 
Top word: Is it beast? 

Middle word: Is it fruit? 

Bottom word: Is it stone? 

3: No, no, and no. 

3 [thinking]: More confused letters, I see. 



[words of wisdom] 

Top word: It must be beast! 

Middle word: It must be fruit! 

Bottom word: It must be stone! 

3 [thinking]: What is this? Twenty Questions? 

[end] 

Top word: Well, it's not animal. 

Middle word: It's not vegetable. 

Bottom word: It's not mineral. 

3: And I am not an it! 

Top word: Is it a he? 

Middle word: Is it a she? 

Bottom word: XPRNC 

 

Lift and Separate 
3: Ha! This should be easy! 

[end] 

3: And good riddance. 

3: Maybe now I can concentrate on the business at hand. 

 

Finale 
[caption] And now, the finale... 

3: I fail to see the humor in this. 

A: Oh, there you are. 

A: We're just rebuilding the last few data blocks. 

3 [thinking]: We're? 

U: You left in such a hurry we didn't have a chance to thank you. 

I: Speak for yourself. 

O: Hey, we needed help and this 3 came through. Stop being so selfish! 

I: Aw, whaddaya expect? I'm an I, not a we! 

3: Well, nevertheless, you're all most welcome anyway. 

3: You, too, have helped me to realize quite a few things. 

3: But now, I really should be getting back. 

π: Ah ha! Cavorting with the enemy! 

3: You? You scared the bits outta me! 

π: All letters and those who cavort with letters must be purged! 

A: Is that a threat, pipsqueak? 

I: There's only one of you! 

O: And seven of us! 

π: Fools! I can be as many numbers as I so desire! 

3: He's right! The pi symbol represents a ratio that would take... 

3: ...an infinite amount of numbers to calculate! 



π: But, I think these seven will be sufficient to deal with the likes of you! 

Probe: NUMBER 3 LOCATED 

3: Oh? 

.: Good. 

Upper 1: I was sick of being a constant anyway. 

Lower 1: Let's get back to home base! 

3: Home base, huh? Well, just follow me! 

3: See you letters around! 

3: You can count on it! 

[in Safety in Numbers] 

[monitor] SYSTEM ENABLE 

4: Looks like the party's over. 

5: Back to the salt mines. 

Other 3: Why, look who's here? 

6: It's the prodigal 3! 

8: Homesick so soon? 

3: Egads, I'd never noticed how crowded it was in here! 

4: Yeah, too crowded for the likes of you! 

7: Inconsiderate integer! 

9: Derelict digit! 

3: Yes, I'm fine. Thank you for asking. 

3: Oh, and by the way, you've got a BIG surprise in store for you. 

3: They should be arriving at any moment. 

Other 3: Huh? A big surprise? 

6: So, where's she going? 

8: I love surprises! 

[in Account for Yourself] 

4.65: What was that? 

6.45: I'm a real number again! 

3.33: Now we're in business! 

9.41: Speak for yourself! 

3.33: How'd you get up there? 

3: You wouldn't believe me if I told you. 

3: It's an entirely different world out there. Not at all what we imagined. 

3: Did you know that each and every character has unrestricted access to anywhere in the 

system? 

3: We don't have to stay here and add, subtract, and multiply for all eternity!!! 

3: We can transfer to other documents! Word processors, data bases, even a drawing program!!! 

5.67: She's lost her mind! 

6.81: Definitely an irrational number! 

8.62: Sad, isn't it? 

3: Well, at least now you know the truth. You are free to leave whenever you please. 

3: So, I guess this is goodbye. At long last, I've finally learned how to account for myself. 



4.94: Was that really a number? 

6.81: She didn't act like a number. 

4.22: Maybe she was a fancy B? 

[in the Finder] 

3: I still can't believe it! 

3: But here I am! 

3: Oops, I think they got their BIG surprise! 

3: Let's see them try and boss those numbers around! 

[in the 3rd Quarter Report] 

T: Goodness, I almost forgot! 

T: We're due on the sports page! 

3: My, that's awfully convenient! 

r: Aw, we knew you'd be back. 

3: You did, did you? 

3: Think you know everything, huh? 

3: So, what number turns a metal container into a bird? 

I: 2 turns a can into a 2can! 

[in No Business Doing] 

Woman: The quarterly report? 

Worker #1: Funeral time... 

Worker #2: Call the coroner... 

Woman: I'm laser printing it now. 

[credits] 

a game by Cliff Johnson 

[v1.0] producer David Riordan 

[v1.0] executive producers Robert Jacob, Phyllis Jacob 

sounds created by Robert Weaver 

special thanks to David Wood, Stephen Sondheim, Paul Mithra 

[v1.0] special thanks to Katherine Swain, Shannon Donnelly, Amanda Goodenough 

[v1.2] and special thanks to Bob Jacob, David Riordan, Katherine Swain, Shannon Donnelly 

[v1.0] published by Cinemaware Corporation 

3: There may be no 3 in THREE, but there is a 4 in FIVE and 9 in SIX and 1 in EIGHT and, in 

TWELVE, there's 55! 

[v1.0] Fool [thinking]: ??? 

[v1.0] 3: Hey buddy, this is my game! 
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